


Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>
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What is "DukeRes" for?

If you have completed all Duke Nukem 3D levels it may be interesting to make own levels 
with self-made textures and animations. You can get a lot of nice stuff from Doom or Quake. 
For instance you may create a TV showing a short spot. To make levels you need files as 
build.exe, names.h and duke3d.grp provided with the original CD or from the Internet. 
Build.exe loads the tiles from the duke3d.grp file or from separate ART-files ("*.art" 
extension). With DukeRes you are able to make changes into the duke3d.grp file (not 
recommended), to add new ART-files to this GRP-file or to make single ART-files containing 
your new bitmaps.
(As you see I'm from Germany and slept to often during English lessons).
 
Starting "DukeRes" the first time

If you have never used DukeRes before, the File New dialog box opens. Just close this dialog 
and enter the File/Options menu. Set the checkbox Autoload last file at startup to 
checked.
Now enter the File/Open menu. Look for your Duke Nukem3D folder and select the file 
"Duke3D.grp". After opening you should see the listing of the content of "Duke3D.grp" in the
upper left corner. (Make sure of having the menu View/Contents Bar checked):

 
Push the plus-sign beside the ART entry and you will see all the ART- files stored in the GRP-
file. Click at the line "TILES000.ART" and the art-view window opens. At the bottom all 
bitmaps stored in TILES000.ART are to be seen in the bitmap selection box. If you now select
a picture with the left mouse button it will be shown in the animation window at the center.
Select picture no. 100. Now the zoom changes to optimal view and the animation starts. 
Select picture no. 80 and move the zoom-slider at the left side of the animation window so 
you can watch real-time zooming. At the right side in the animation settings field set the End
position to 83, select "oscillating" and push the test button. 

After having enjoyed, revoke all changes you made until the star in the DukeRes titlebar 
disappears.

It's time to make your own ART file. Choose File/New menu command and select "Duke ART 
file" in the File New dialog box. As you see in the title bar, the name of the new ART-file is 
"Tiles015", reminding you, that you never should make changes into the first 13 original files
if you want to play the original Duke Nukem 3D later. Select the only bitmap you find in the 
bitmap selection box . Copy the bitmap into the clipboard using the context menu (right 
mouse button) or press CTRL+C. Select the second field of the bitmap selection box and 
paste the bitmap into this position (CTRL+V). You may paste every other bitmap into 
DukeRes that isn't larger than 512x512 pixels and have 256 colors. Look how the bitmap 
changes with different Duke palettes: Enter the Tools/Load Palette menu and load palette 1. 



Select the palette combo box at the right side of the menu bar and test all available 
palettes.
Do this 4 more times and select the second bitmap. Then change the x-offset to 1 for this 
tile, to 2 for the next and so on - up to the last one. To do this use the right offset button (>) 
below the animation window. The x-offset is shown at the left of the animation window. 
Select the first bitmap (the yellow number should be 3840) and set the End position of the 
animation settings field to 3844. Set the speed the animation type to "oscillating". Now push
the test button - your first animation is ready.
There are two ways to store this ART-file: 
· With the File/Save menu you saves "Tiles015.art" as a single ART-file. Please select the 

folder with the build.exe as the saving location.
· Use the File/Insert into Grp menu to add the tiles to the original GRP-file.
Now you can use the new tiles while working with build.exe.

How To ...
<<add your application-specific "how to" topics here>>

Commands
File menu
Edit menu
View menu
Tools menu
Window menu
Help menu



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Close All Closes all opened documents including the GRP-file. This menu 

item is only available, if no ART-file is currently open.
Save Saves an opened document using the same file name.
Save as single 
Artfile

Saves an opened document to a specified file name.

Extract from Grp Saves a file that is embedded in the GRP-file as a single file.
Insert into Grp
Print (not yet ready) Prints a document.
Print Preview (not yet ready)Displays the document on the screen as it would

appear printed.
Print Setup (not yet ready)Selects a printer and printer connection.
Options Opens the preferences dialog box for the general settings.
Send... (not yet ready)Sends the active document through electronic 

mail.
Exit Exits DukeRes.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Contents 
Bar

Shows or hides the contents bar



Tools menu commands

The Tools menu offers the following commands:

Show Cross Wires Shows a vertical and a horizontal helper line 
in the animation window

Load Palette/Palette1,2... Loads the Duke color palettes
Save Palette/Windows Format, 
Paint Shop Pro Format

Saves the Duke standard color palette as a 
palette file (*.pal)

Save Names Saves the tile's names in a "names.h"
User Defined Application Launches an external application



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 
2, ...

Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Help 
Topics

Offers you an index to topics on which you can get help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new document in DukeRes.    Select the type of new file you 
want to create in the File New dialog box.    << Remove previous sentence if your application 
supports only one document type. >>

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



File New dialog box

<< Delete this help topic if your application supports only one document type. >>

Specify the type of document you wish to create:
<< List your application's document types here >>



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple 
documents at once.    Use the Window menu to switch among the multiple open documents.  
See Window 1, 2, ... command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:
<< List your application's file types here. >>

Drives
Select the drive in which DukeRes stores the file that you want to open. 

Directories
Select the directory in which DukeRes stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    DukeRes suggests 
that you save changes to your document before you close it.    If you close a document 
without saving, you lose all changes made since the last time you saved it.    Before closing 
an untitled document, DukeRes displays the Save As dialog box and suggests that you name
and save the document.

You can also close a document by using the Close icon on the document's window, as shown 
below:



Save command (File menu)

Use this command to save the active file to its current name and directory.    If a GRP-file is 
loaded and you modified one part of this file, the GRP-file is updated, but its path doesn't 
change. If the active document is a single ART-file (no GRP-filename precedes the ART-
filename in the titlebar) When you save a file for the first time, DukeRes displays the Save 
As dialog box so you can name it.

Shortcuts

Toolbar:
Keys: CTRL+S



Save as single Artfile command (File menu)

Use this command to save and name a Art-file that was former a part of a GRP-file as a 
single file with the ".art" extension. DukeRes displays the Save As dialog box so you can 
name your artfile.    This may be necessary if you want to watch the artfile with editart.exe. 



Insert into Grp (File menu)

Inserts the newly created ART-file into the original duke3d.grp or into a previously created 
GRP-file.



Extract from Grp File menu)

Each file type may be extracted from a GRP-file. This GRP-file must be loaded before. Select 
the file into the contents bar and push the extract button or extract via context menu (right 
mouse) of the contents box.



Send command (File menu)

Use this command to send the active document through electronic mail.    This command 
presents a mail window with the active document attached to it.    You may then fill out the 
To: field, Subject: field, etc., and add text to the body of the message if you wish.    When you
are finished you may click the "Send" button to send the message.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters. DukeRes adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Options command (File menu)

Use this command to change the following settings: 
1. Options

1.1. Autoload last file at startup (default off)
Loads the file that was opened the last time you launched DukeRes the next time 
automatically. So you needn't load the file every time using the File/Open menu.

1.2. Autostart animation (default on)
If a ART-file is loaded and you select a bitmap into the bitmap selection box, the 
animation window immediately starts to animate if the following settings are given: the 
starting bitmap is selected, the value for the Start must be lower than the End position 
for forward and oscillating animation and higher for the backward animation. The 
animation type.

1.3. Show filled contour in preview mode (default on)
For better positioning of animated bitmaps you can press one or both of the contour 
buttons. This shows the contour of the previous or the following bitmaps (monsters...). 
With the option mentioned above you can decide to show a filled or unfilled contour.

2. Tools
You need some external applications to process the bitmaps or extract them from other 
games. For faster access you can define 4 toolbar buttons for these applications. To add a 
link choose the Add button. With the now opening File Open dialog select the tool desired 
(PSP...) and choose "Open". The name appears in the listbox of the options dialog. Select it
and choose a custom toolbar button.



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)

Use this command to end your DukeRes session.    You can also use the Close command on 
the application Control menu. DukeRes prompts you to save documents with unsaved 
changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

<< Your application's user interface for Undo may differ from the one described below.    
Modify this help text accordingly. >>

Use this command to reverse the last editing action, if possible.      The name of the 
command changes, depending on what the last action was.    The Undo command changes to
Can't Undo on the menu if you cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on 
the clipboard.    This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in DukeRes, such as File Open.    A check mark appears next to the
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in DukeRes,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click at the desired toolbar button to get more information.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the DukeRes window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Contents Bar command (View menu)

Use this command to display and hide the Contents Bar, which let you select the content of 
a GRP-file as it would be a folder with single files.    A check mark appears next to the menu 
item when the Contents Bar is displayed. This window should only be closed if your screen 
size is to small to operate with the controls at the right border of DukeRes.

See Contents Bar for help on using the contents bar.



The Contents Bar

If a GRP-file is loaded via the File/Open or File/Recent File command, the contents bar shows 
all files embedded into the GRP-file. If there is a "plus"-sign beside the file type name, there 
are files of this type within the GRP-file. The following file types are currently processed by 
DukeRes :

1. Art
1.1. Duke Nukem ART-files (.art)(Quake SPR- and LMP-files later)

2. Maps
2.1. Duke Nukem MAP-files (.map)

3. Sound
3.1. Midi sound (.mid)
3.2. Creative Labs wave files (.voc)

4. Animation
4.1.Duke Nukem animation (.anm)

5. Data
5.1. Duke Nukem configuration files (.con)
5.2. Duke Nukem TMB-files (.tmb)
5.3. Duke Nukem BIN-files (.bin)
5.4. Duke Nukem data files (.dat)

*modified by DukeRes 
To load a ART-file for processing click with the left mouse button at the file's name (maybe 
later double-click). To extract a file (all types) click with the right mouse button and select 
Extract from Grp.



Show Cross Wires command (Tools menu)

Shows a vertical and horizontal line at the animation window. These lines are for better 
setting the offsets in creating animations. The Lines can be moved my mouse.



Load Palette - Palette1, 2... command (Tools menu)

Loads the Duke palette(s) from the "duke3d.grp" -file or a separate "palette.dat". If the 
palettes are already loaded it selects one of the (commonly) 10 palettes. Every palette 
includes 32 sub-palettes with a different brightness. You can choose them by the palette 
combo box. The use of the palettes is only for informative purpose, it's not saved with the 
bitmaps.



Save Palette - Windows Format/Paint Shop Pro Format command (Tools menu)

The Duke tiles are stored in the ART-file without palette informations. I f you didn't have 
loaded all available Duke palettes with the Load Palette command, DukeRes provides a 
standard palette. This standard palette shows the picture in their normal appearance. You 
can save this palette as a Windows palette file (.pal), or
as a Jasc Palette (.pal).
Later you may use this palette, to adapt your custom graphics for use with Duke Nukem.



Save Names command (Tools menu)

Some Duke tiles are named for better finding special graphics or to find the starting picture 
of an animation easier. The original names are stored in the "defs.con" -file - a part of 
"duke3d.grp". In DukeRes you can modify these names or add some for your own 
animations. If you save the names in a special "names.h"-file in the folder where "build.exe" 
and "editart.exe" are residing, you can use the names while making custom maps.
(Rename the original "names.h" before !).



User defined Application command (Tools menu, renamed after adding a tool)

This command launches the application you earlier added via the options dialog box. This 
command doesn't open the selected bitmap automatically, whereas the bitmap box context 
menu does.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You
can open multiple document windows to display different parts or views of a document at 
the same time.    If you change the contents in one window, all other windows containing the 
same document reflect those changes.    When you open a new window, it becomes the 
active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... command (Window menu)

DukeRes displays a list of currently open document windows at the bottom of the Window 
menu.    A check mark appears in front of the document name of the active window.    Choose
a document from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using DukeRes and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
DukeRes. The author's home page is to be found at: 
http://members.aol.com/Pgerber1/index.html
mail: Pgerber1@aol.com



Context Help command 

Use the Context Help command to obtain help on some portion of DukeRes.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the DukeRes window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



The available Palettes

After a Duke palette is loaded via Tools/Load Palette, you can test the appearance of the 
picture in the animation window by choosing different palettes with this combo box.



Title Bar

<< Show your application's title bar here. >>

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application

Name of the document

Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.

<< Describe the actions of the various parts of the scrollbar, according to how they behave 
in your application. >>



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the DukeRes window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title 
bar.

Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    DukeRes determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    DukeRes determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the DukeRes window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Animation Window

This window helps you to view and change the tiles settings as position and animation. Use 
the marked controls as followed:

1. Animation window - Click with the right mouse button to flip the background from white
to black (not saved).
2. Zoom slider - performs real-time zooming from minimal (lower position) to maximal size 
(upper position). The marker at two third of the length indicates the original size. You can 
move it with the arrow keys (not saved).
3. Maximize button - Sets the maximal zoom for this bitmap (not saved).
4. Minimize button - Lowest zoom (not saved).
5. Left offset button - Decreases the horizontal offset. The bitmap appears more left in the
game (saved).
6. Right offset button - Increases the horizontal offset. The bitmap appears more right in 
the game (saved). 
7. Lower offset button - Decreases the vertical offset. The bitmap appears lower in the 
game (saved).
8. Upper offset button - Increases the vertical offset. The bitmap appears higher in the 
game (saved). (the last four settings prevent tottering animations).



Bitmap selection box - context menu commands

Cut Deletes the bitmap from the ART-file and moves it to the clipboard
Copy Copies the selected bitmap to the clipboard
Paste Moves a bitmap that was previously copied from the clipboard into the ART-file
Import Opens the Open File dialog to select a PCX- or BMP-file. This file is copied into the

selected position
Delete Removes the bitmap from the ART-file without moving into the clipboard
Move (not yet ready)
Rename Changes the name of the picture in the "names.h"-file. The edit-field opens just 

below the bitmap
Edit with Opens the application that was first added as a helper tool in the Options dialog. 

The bitmap is be saved as a BMP-file and the application opens it.
Save as 
file

Saves and names the bitmap as a BMP-file



Bitmap selection box

The bitmaps are shown in the same order as they are contained in the Artfile. The size is 
equalized to fill the space optimal. The number of bitmaps per ART-file may be changing 
from game to game (Duke Nukem 3D - 256). In the upper left corner of each picture you see 
the continuous number starting from 0 (bitmap 1 in tiles001.art) up to 3839 (picture 256 in 
tiles014.art). 
Edit the bitmap's names by double clicking the bottom of the bitmap. After typing the new 
name click beside the opened edit-field and the field closes. These names can be saved 
using the Save Names command of the Tools menu. 
The picture is shown in the animation window by selecting it with the left mouse button. 
There you can edit the bitmap's properties.
Left mouse clicking opens the context menu with some command as cut, copy, edit... .



Animation settings field

Start - Sets the number of the first picture in a series of bitmaps Duke Nukem uses to 
produce an animated object (for instance burning barrel). This number is automatically 
set, if you select a tile in the bitmap selection box.

End - Sets the number of the last bitmap shown in a animated picture series. This number is
set to be the same as the start bitmap, if you select a tile in the bitmap selection box. If 
you change the animation type from forward/oscillating to backward and vice versa, the 
end-number is automatically corrected.

 - none - No animation.
- oscillating - If the animation reaches the end bitmap, the animation-direction 
changes and the next picture to show is the last but one bitmap 
(start,start+1,start+2,....end,end-1...start...).
- forward - If the animation reaches the end bitmap, it continues with the first 
bitmap again (start,start+1,start+2....end, start...).
- backward - The number of the start picture is higher than the number of the end 
picture. If the animation reaches the start bitmap, it continues with the end bitmap 
(start, start-1,...end, start...).

Speed - Sets the animation speed. The higher the number, the lower the speed.
Test - Runs the animation test. The test is canceled, if you select another bitmap than the 

starting bitmap or you set the animation to none. The test doesn't run, if start and end 
number are equal or the animation type is set to none.



Start field (Animation settings field)

Sets the number of the first picture in a series of bitmaps Duke Nukem uses to produce an 
animated object (for instance burning barrel). This number is automatically set, if you select 
a tile in the bitmap selection box.



End field (Animation settings field)

Sets the number of the last bitmap shown in a animated picture series. This number is set to
be the same as the start bitmap, if you select a tile in the bitmap selection box. If you 
change the animation type from forward/oscillating to backward and vice versa, the end-
number is automatically corrected.



No animation (Animation settings field)

No animation.



Oscillating animation (Animation settings field)

If the animation reaches the end bitmap, the animation-direction changes and the next 
picture to show is the last but one bitmap (start,start+1,start+2,....end,end-1...start...).



Forward animation (Animation settings field)

If the animation reaches the end bitmap, it continues with the first bitmap again 
(start,start+1,start+2....end, start...).



Backward animation (Animation settings field)

The number of the start picture is higher than the number of the end picture. If the 
animation reaches the start bitmap, it continues with the end bitmap (start, start-1,...end, 
start...).



Speed field (Animation settings field)

Sets the animation speed. The higher the number, the lower the speed.



Test/Stop button (Animation settings field)

Runs the animation test. The test is canceled, if you select another bitmap than the starting 
bitmap or you set the animation to none. The test doesn't run, if start and end number are 
equal or the animation type is set to none.



Show Contour

Next Contour - Shows an overlay of the next figure (red).
Prev. Contour - Shows an overlay of the previous figure (blue).

This may be helpful if you create an animation and want to prevent tottering by changing 
the offsets.
In the Options dialog box you can decide to show a outlined or filled contour.



Insert ART File dialog box

Opens after a naming conflict between the new ART-file and one of the already existing files.
There are three ways to solve the problem:
1. Rename - The new file gets a new name with the last three characters before the 
extension representing the next free number.
2. Replace - The name keeps unchanged and the files replaces the ART-file that already 
exists with the same name in the GRP-file (not recommended for the original ART-files 
TILES000 - TILES013).
3. Cancel - The insertion is canceled. You may save the ART-file as a single file using File 
Save command.



Tools property sheet

You need some external applications to process the bitmaps or extract them from other 
games. For faster access you can define 4 toolbar buttons for these applications. To add a 
link choose the Add button. With the now opening File Open dialog select the tool desired 
(PSP...) and choose "Open". The name appears in the listbox of the options dialog. Select it 
and choose a custom toolbar button.



Preferences property sheet

1. Autoload last file at startup (default off)
Loads the file that was opened the last time you launched DukeRes the next time 
automatically. So you needn't load the file every time using the File/Open menu.

2. Autostart animation (default on)
If a ART-file is loaded and you select a bitmap into the bitmap selection box, the 
animation window immediately starts to animate if the following settings are given: the 
starting bitmap is selected, the value for the Start must be lower than the End position 
for forward and oscillating animation and higher for the backward animation. The 
animation type.

3. Show filled contour in preview mode (default on)
For better positioning of animated bitmaps you can press one or both of the contour 
buttons. This shows the contour of the previous or the following bitmaps (monsters...). 
With the option mentioned above you can decide to show a filled or unfilled contour.



Modifying the Document



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.




